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About Flip Shopping Catalog

Flip Shopping Catalog is helping to build digital
catalogs with realistic page-flipping effect. It
provides a new and interesting way to promote
and sell products online. The Flip Shopping Catalog
program is easy-to-use, and will help to build a
shopping book within minutes, output to multiple
formats you can use, like HTML to publish online,
ZIP or Burn to CD to send to clients, EXE to play
individually in your store, mobile version enables
users to view on iPhone, iPad and Android devices.
The wonderful look digital catalogs will definitely
impress your clients with so many interactive and

powerful features.

Note: This product is distributed on a "Try before-you-buy"
basis. All features described in this documentation are
enabled. The registered version doesn't insert a watermark in

your generated page-flipping eBooks.
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Product features

10.
11.

12.

13.

14.

15.

16.

Convert PDF to Adobe© Flash® based digital shopping catalogs with
page-flipping effect.

Batch convert multiple PDF files to a single or multiple page-flipping eBooks.
Provide command line version.

Import bookmarks (outline) with PDF, and edit them manually.

Import hyperlinks with PDF, include web link, page link, email link.

Import text so text is searchable, define the minimum search characters.

Detect landscape page to present as two-page spread.

Add watermarks text, image, dynamic date/ time etc to page-flipping eBooks.

Define quality and size for normal version and mobile version.
Detect landscape page to present as two-page spread.

Output in different formats: HTML, EXE, Zip, Mac App, Mobile version and Burn
to CD.

o HTML allows you to upload to a website to be viewed online (with title,
keywords and other metadata defined).

o EXE (with setting title, icon and open window size) and Zip allow you to
send to your user by email to be viewed on their computer.

o App (Mac Application) is executable application can be run on Mac.

o Mobile version is to output HTML flipbook which can be viewed on mobile
devices via Browsers.

o Burn to CD allows you to burn to disk so you can send your user physical
media for viewing on their computer.

Apply a pre-designed template.

Preview the output effect instantly.

Add HTML Title in Float template which can be clicked to visit webpage online.
Add Image or Flash logo to insert before Book Title in Float template.

Define book proportions, margin size, shadow manually.
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17.

18.

19.

20.

21.

22.

23.

24,

25.

26.

27.

28.

29.

30.

31.

32.

33.

34.

35.

36.

37.

38.

30.

Replace existing icons on toolbar by editing Icon Flash file.

Add new icons into toolbar with calling new actions.

Set background color and image.

Insert background music either for continuous play (loop) or for a set duration.
Set eBook reading from right to left (for Right-to-Left languages such as Arabic).
Choose hard cover for eBooks.

Set fonts for Flash and Bookmark, Search panel.

Set Page Number Box to show at top or bottom in Float, set start page number.
Add shopping projects to pages, like Price, Order buttons, Product photos,
Shopping icons, etc.

Edit pages with embedding links, images, movies, flash, sound or You Tube video
files.

Add Button on pages to open link page, call Javascript action, play Flash/Video in
pop-up Window.

Copy projects from one page to another or all the other pages.

Define the language for your published page-flipping eBook (support
multi-language show and switchable).

Add password to protect your page-flipping eBook.

Add Google Analytics Support.

Add watermark image or SWF to show on print out pages.

Add Help config to manually define content with using Image or SWF.

Add Single/Double Page view.

Add Minime Style to show page-flipping eBooks without toolbar.

Set permissions for downloading, printing, social sharing, Home, About button
and more.

Edit bookmark manually and set bookmark panel to show on left or right side.
Export and save settings for future uses.

Save and Load your project.
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Page-flipping eBook features

With the page-flipping ebook you have created, your user will be able to:

10.

11.

12

13.
14.

15.
16.
17.
18.
19.
20.

21.

Show Product Shopping Catalog online with page-turning effect.

Click button, link, and text on pages to go to product or order web pages.
Drag the corner or page frame to flip pages.

Click navigation buttons on toolbar to turn pages.

Input password to unlock encrypted pages.

Single/Double Page view.

View with pre-loading needed pages to open quickly, do not need to wait all
pages loaded.

Use button to control page, such as Previous, Next, First, Last etc.

Flip pages automatically.

View flipbook repeatedly.

View page-flipping ebook full screen.

. Use thumbnail to navigate.

Search whole eBook.

Print out the whole ebook or a range of pages directly (support to clip area on
pages and then print).

Download the uploaded page-flipping eBook from web site directly.
Double-click to zoom in or zoom out.

Zoom in/ out both pages.

Share eBook url via email.

Open or close page-turning sound.

Open to a certain page in Browser by adding a suffix like this:
index.html?pagelndex=4.

View output page-flipping eBook on iPad, iPhone and Android devices (slide

single pages mode supported).
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Quick Start

\
1. Launch the application via the desktop shortcut;

2. Click the "Import" icon "'I:I to enter into Import PDF interface;

3. Click "% Jicon to choose PDF file from your computer;

4. Click Mjicon to enter into template setting interface;

5. Edit shopping page objects, define parameters for eBooks, such as

Book, Tool Bar, Bookmarks, and then click the "Apply Change" icon ;

Ty &

vl L

6. Click "Convert to Flipping Book" icon i to enter into Output

interface;

7. Choose Output Type from HTML, ZIP and EXE, here take
QL;'?;;?/ & = himl

- as example;
8. Click L Z2"=: J{5 set Output Folder as "C:\flipbook", input File Name
as "demo";

Convert

9. At last, click icon to output created page-flipping eBook.

You can open the "flipbook" folder in "C:", there are three files in this folder:

o @

files book.swf demo.html
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Open the "demo.html" file to view your created p0Oage-flipping book via Web
Browser, such as Internet Explorer, Google Chrome, Firefox, etc.

& demo - Windows Internet Explorer E=RE=l x

A |e_ C\flipbook\demo.html v l ‘yl X ‘ | Bing ped -

3¢ Favorites | 53

@ demo f v B - = ® v Pagev Sofetyv Toos~ @~ ~

W -
s“opp\“g
ca‘a\og $

‘/ e

< Digital shopping catalog
< Realistic page flipping effect

< Shopping easy online
F \

Internet | Protected Mode: Off ‘3 v ®100% ~
)

Interfaces

There are some main interfaces you will see while using Flip Shopping
Catalog as below shows: Application Options, Import PDF, Template
Settings, Edit Pages, Language Option, Export Theme, Output, Batch
Convert and Command Line.

You can enter into each page to get clear instructions for every detail

option.
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I. Application Options Interface
1. Render Engine Option

Flip Shopping Catalog provides 3 different render engines for you to create higher
quality page-flipping eBooks (change option when PDF imported failed), click
"Options->Application Options" to enter into "Render Engine" interface:

SWF: Much legible characters, smaller output size

GPL Ghostscript: Higher color transfer quality

Inner Library: Faster convert speed

Render Engine

Please selecte a render engine for the conversion

SV
SWF
v

GPL Ghostscript Rondoad Ghostecript

r

Q) [nner Lbrary

SWF: Much legble characters, smaller output size
GPL Ghostscript: Migher color transfer qualty

Inner Libcary: Faster convert speed

'

Cancel

2. Create Mobile Version Option

(1) Pages Quality and Size
Five types of "Pages Quality And Size" for mobile version eBooks:

' Pages Quality and Size

Quality And Size:  |Higher quality larger file size v

gher quality larger file
High quality large file size
. Medium quality medium file size
L Eﬁt}::lﬁre: : Low quality small file size
Lower quality smaller file size

(2) Mobile Template

The current version provides two mobile template modes for you to use: Slide and
Single Page Flip. The later one adds page-flipping effect on the pages while viewing
in mobiles.
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1/4

Il. Import PDF Interface

Source PDF Flie

Browse.. ] [ Open it
The Page Ranges to Import Watermark
© All pages LA 4 Place a custom text or image
() Custom range: | 1-10 Evs 35 9. ‘ ~7 Watermark(Stamp) to the file(s)
Quickly import (Only import 10 pages to initial preview) Set Watermark
Page Quality
Quality And Size: [Medium quality medium file size ']

% High values produce better page quality but require more disk space and more time to download.

[~} import bookmark [¥] Import links [¥]Enable search [ Detect wide pages

[ Import Now ] [ Cancel ]

1. Source PDF File:

Click this icon to open the PDF file you want to convert;

OpEnit | view content of added PDF file to clarify before converting.

2. The Page Ranges to Import:

©alpages  convert all pages to page-flipping eBook;

@ Cust 22-5 E :1,3,5,9-21 .
» LaslomTange e Convert defined range page;

7] - . o T T o § . .
[V] Quickly import (Only import 10 pages to initial preview) Just preview effect on first 10 pages.

3. Watermark

Add image or text watermark to flipping pages.

v ing W . . .
(@] Applying Watermark Check this option first to choose default stamps or add new ones:
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)0 Text Wotermark oS
% Add Text Watermark
Text Name

Name:  Text Watermark

Text:  Page-Appng eBock.
Text Propertes
tont (@rehesen
Sre: 24
style:  [7]gog
Text Layout
L P —
Tig Style
Poston nmargns  Marging
P ™)

el re} - .
1= [3]] = eE E b - S Page-flipping eBook

Text Effect
Ogsdty: 0%
Yy Rotaton: ]

Edit /4 =
Add text stamp foee

Add image stamp A imsge Wotermark

3]

‘Add Image Watermark
Delete Inage Name
Name:  Image Watermark

Move down i )

> ¢ X 8 &

Move up m":’” = o e =

16t to margns. @ Stretch to margns E
Image Effect
Qoadty: 0% o100%
Rotaton: 0 *! degree. ) s background
Postonnmagns  Margns

Py v
oo R e

4. Page Quality
There are five types of "Quality And Size":

figh

i ity large file size
Medium quality medium file size
Low quality small file size
Lower quality smaller file size

5. Other Options:

[7] import bookmark If your PDF file contains bookmarks, check this option to use in output

page-flipping eBook;

V| import links If your PDF file has links, check this to enable in flipbook;

[V]Enable search Check this option to enable search functionality in created flipbook.

[V|Detect wide pages  cpock this option to make landscape page in PDF file to be presented as

two-page spread in output flipbook.

At last, click icon to enter into template setting interface.
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lll. Template Settings Interface

|5 Fiip Shopping Catalog Unregistered 100 —- Flip Shopping Catalog Classical > o E L 0§ =)

File Convert Qptions Opline Help E—
/4 Import Shopping Catalog (POF) ;msnmcm € Apply Change ', Convert To Flipping Book EWmm (&) Batch Convert

Design Setting | Bookmark |
Tempiates

1/12

Br= | 2
Please customaze the flash tempiate here
|00l Bar Settings ‘
ETitle Bar
BlButtons Bar |
Tool Bar on top Faise |
Add Icons Settings
ElButton Icons
ElFiash Display Settngs |
Background Alpha 1
Retain the book to center Yes
ElFont
B8uttons
Font Color Cloxfeef
Button Font Tahoma
BTite and Windows
Window Font Color | CJOxfffff
Window Font Tahoma
BBookmark
Bookmark Font Color | CJ0xffff % Digital shopping catalog
Bookmark Font Tahoma ] R St
Eiearch “Realistic page flipping effect |
Search Result Font ... | CIoxfFffff “Shopping easy online
SearchResultFont | Tahoma I \
Tool Bar Settings \
g‘ Set options for the buttons and ! gl 4
3 |icons on the Tool Bar il s
W e T

TN A 3 ‘

0?7 & B w9 Q@ Q = {§ » « < > »

The design setting interface contains below main parts: Choose Template, Tool Bars
Settings, Flash Display Settings and Flash Control Settings.

1. Choose Template
Templates

‘ Iff ciassical ’E] B

Please customise the flash template here

ﬂ Classical ‘H
icon to select templates from below interface:

|5 selecta Tem
| L Choose a fipbook template here. (Double-click to make a quick selection)
| ¥ (More and more templates will be provided in future.)

r

Click ‘

Get More Themes Onine
Templates = - — - — — s
== an
[H8] Classical (1] n 4
FH] Fioat = ‘
E Spread sorw Bues Colorfs =

Refresh

Download more themes from FlipBuilder now:
http://www.flipbuilder.com/templates-themes/theme.html .

Copyright 2010 by FlipBuilder.com
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‘E"J Click this icon is to save current settings as a TXT file for later uses;

=2 Click this icon is to import stored setting file at once.

2. Tool Bar Settings

I[IElTooI Bar Settings
‘ HTitle Bar

’ [#HButtons Bar

| Tool Bar on top |False
| Add Icons Settings

! EHButton Icons

(1) Title Bar (only in Float template)

| BTitle Bar
The Book Logo C:\Users\Admini...
Logo URL http: //flipbuilder...
Book Title | <a href="http://...

__Page Number Box On ... |False B

{y FLIPBUILDER.COM |

Customize book title and logo for showing on the top of your flipbook. You are enabled to
set the book title as HTML format text. For example: <a href="http://www.flipbuilder.com'
target='_blank'>FLIPBUILDER.COM</a> | <font color="#ff0000' size='14'>Red Color</font>

(2) Buttons Bar

EButtons Bar

Home Button

About Button
Full Screen Button Show

Help Config

Print Config

Download setting

Sound

Zoom Config

Search

Share

Auto Flip
Thumbnail Button Enable
Single Page Disable

i. Home Button

You can add a home buttonm to help reader to click and go to your website directly:

Copyright 2010 by FlipBuilder.com
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| ElHome Button |
Home Button Visible Show
Page URL http: /flipbuil. ..
Open Window |Blank

ii. About Button

Add About button to show the author, contact, book, company info:

[EAbout Button
About Button Visible |Show
Content <textformat |

Click "..." to enter into "About & Contact" edit interface:

About & Contact Settings

Flip PDF Professional DemoBook -
Presents powerful features in the Flash digital eBook, such as social share, print, autoplay
etc.

Contact us at: alice@flipbuilder.com
http: //flipbuilder.com

K Clear
Q Save As..
Q;J Load..
3 pemo

i

hyperlinks and so on.
More details about tags please: Click Here

You can use some “tags” to format the text shown in the "About & Contact” window, such as text font, font color,

[ o |

l Cancel ‘

After clicking the About button, you will view the About window by clicking the button:

{, About & Contact X

Flip PDF Professional DemoBook

Presents powerful features in the Flash digital eBook. such as social shars, print.
autoplay etc.

Contact us at: alice@flipbuilder.com

http:/flipbuilder.com

iii. Full Screen Button

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen

Button" option: Full Screen Button Show

Then you can click icon E to view flipbook in Full Screen, click icon n or "Esc"

button to exit from the Full Screen.

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode,

you can set "No" in "Full Screen without Tool Bar" (just in Classical Template):

Full Screen Without Tool.. | Yes

Copyright 2010 by FlipBuilder.com
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iv. Help Config

ElHelp Config
Help Button Show
Help Content File -type.png |
Help Window Width 400
Help Window Height 450
Show Help At First Show

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you

can define Help Content manually by inserting "Help Content File (image or SWF)", also

enable to define the Width and Height of the Help image or swf. If you set "Book->Retain the

book to center->No", you can set "Show Help At First->Show" to display the Help Panel with

the Book as below:

4 ;.._i-a_i_ﬂ Y
Help:

Double-click to zoom in/z0om out;
Drag the page corner or
Use mouse wheel to flip pages.

FLip PDF

You can also click the button to view the same Help page in pop-up window.

v. Print Config

EPrint Config ‘
Print Enable |Yes

Print Wartermark File |[=5) e

ona

Choose "Yes" in "Print Enable", then click icon to set print page range as below:

& Pnnt

=) Print Al Pages
) Print Current Page

_) Print Range
Example; 2,5,8-26

L

& Print

4

You can also click "Print Watermark File->..." button to choose image or SWF file from your

computer as watermark on printed out pages.

Copyright 2010 by FlipBuilder.com
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vi. Download Setting

ElDownload setting i
Download Enable Yes [
| Download URL DFDemo.pdf !

If you want your flipbook readers to download the PDF file or the flipbook directly from your
website, select "Yes" in "Download Enable" option, then input the Download URL directly,
you can use absolute path like
"http://www.flipbuilder.com/flip-pdf/example/files/download/FlipPDFDemo.pdf" or relative
path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the PDF to the
same path).

Then readers can click the icon n to download your uploaded PDF file directly.

vii. Sound

ElSound 1
Enable Sound Enable ‘

| SoundFie rples.mp |
Sound Loops % ‘

If you want to add background sound to your flipbook, such as a song or other audio file, set
"Enable Sound->Enable", then click " =|" icon to choose "Sound File" from your computer,
then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing
flipbook, other value (N>0) stands for the times of playing the sound file.

viii. Zoom Config

ElZoom Config
Zoom in enable Yes
Zoom Scale 1.5

To Enable Zoon In functionality, choose "Yes" in "Zoon in enable", then set "Zoom Scale", the
value is the times between zoomed page size and the current page size.

In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by

the zoom in tool like this: m You can also set "Scroll

with mouse->Yes" to scroll zoom in page while moving mouse.
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ix. Search
| searchButton Show J

|  Search Highlight Color [JoxFFFF80 ]
| leastsearchcharacters |3 |

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in
"Import PDF" interface), then define "Search Highlight Color", after clicking "Search" icon

m, you will see a popup box to input search words, then click Enter or "Search" button,

you will get the below searching result:

x. Share

ElShare
[ Share Button ‘
Social Share Button  |Show

You can share via emails, or just through Facebook, Twitter, Google, etc..

a. Share Button
If you want readers to share via Email, you can enable "Share" feature as below shows:

[EShare Button
Share Button Show
Email Subject Rear my fi...
Email Body {link}

When the viewers click the share button E, they will enter into the Email interface with

the link of your flipbook in the Email body.

b. Social Share

If you want your flipbook viewers to send the link to their friends or clients via Facebook,
Twitter, Linkedin, Google, Yahoo and so on, you can add a Social Share button in your
flipbook for readers to send out your flipbook link immediately:

| SocalShareButton __[Show

The readers just need to click the "Social Share" button @, then the below window will pop

up for them to choose share channel:
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Social Share

Microsoft Word - demo3.docx Facebook I Twitter
in Linkedin Google
B_Del.icio.us Yahoo
: EiK Diag [0} StumbleUpon
£ ve 4ok Ak

{®| Reddit m Mixx
£ Technorati '+ More

& http://www. flipbuilder.com/flip-pdf/example/

xi. Auto Flip

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the
Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times
of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip

button “, the flipbooks will be flipped by staying 3 seconds per page); if you want to

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes":

BlAutoFlip o
AL e B
. FipInterval B
Play Count ok
Auto flip when startup | Yes

xii. Thumbnail Button
| Thumbnail Button |Enable |

Show Thumbnail Button E(set "Enable") to view page thumbnails of your book, or you can

Disable it to hide the button.

xiii. Single Page

[ Single Page |Enable |

If your book contains landscape pages, or the page content is different to read for the font is too

small, you can set "Single Page->Enable" to enable readers to click "Single Page" icon n to

view pages one after another, then click "Double Page" icon m to back to the normal book

reading mode.

(3) Tool Bar on Top (only in Float template)
If you want to place the toolbar in Float templates on the top of the flash eBook, you can set
"Tool Bar on Top" as "True":
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Tool Bar on top [True

(4) Add Icons Settings
If you want to add some other kinds of buttons which the program doesn't provide, you can click
"Add Icons Settings->..." to enter into "Icons Settings" interface to add new icons on tool bar:

: Add Icons Settings
B/ lcons Settings M

| Config icons for toolbar
\
|

€ Remove keon 5 Qe 4 moes G movepomn

Action Type Acton Content

N |

Source Fle:  C:'Users\Administrator\DesktopWew foider mage: _Qm Open

Button Info
Caglon: GoToPage 6

Tcon Sutton Acton
9 Go t0 page Open a Ik Cal Javascriot function

Page Index: 6

You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. After your "Apply Change", the new added icon will show in the toolbar. (More
details about Call Javascript function will be introduced in the part of "Edit Page->Add Link".)

(5) Button Icons
Define settings for the icons of the buttons:

ElButton Icons 5
Icon Color | CJoxffffff
Icons File(SWF Only)

Copyright 2010 by FlipBuilder.com
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i. Icon Color

Icon Color | JoxFFFFI =]
o r = Q

ii. Icon File

Select the Tool Bar Button to replace with your own icon.

[ Icons File(SWF Only) [C:\users.. |

More details please view here:

http://www.flipbuilder.com/support/how-to-replace-icons-on-flash-toolbar.htm

3. Flash Display Settings

[EIFlash Display Settings
Retain the book to center |Yes
Language \English
[HFont
Initial Show \None
EBackaround Config ‘
Flash Window Color W 0x454545
Page Background Color | CJOxffffff
[#EBook Proportions
[#EBook Margins
[EPage Shadow
Hide Book Frame Bar No
Right To Left \No
Hard Cover \No
Flipping Time 0.6
EPage Number ‘
EMinime Style

(1) Retain the book to center
[ Retain the book to center |Yes ~]

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for

embedding special background image, such as advertisement or company log.

(2) Language

|_Lanquage English__v|

You can set language for showing tools or tips in your created flipbook, and here is the

specialized instruction page for setting the "Language Option".

(3) Font

ElFont
ElButtons ,
Font Color | Cloxffffff
Button Font | Tahoma
EHTitle and Windows
EHBookmark
HSearch

Copyright 2010 by FlipBuilder.com
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If you want to change fonts of toolbar buttons, flash windows even bookmarks or search
result panel, you can set font types and colors in Font Panel.

(4) Initial Show (set in Float/ Spread templates)
You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just
select "Bookmark" or "Thumbnails" in this option:

For Example, select "Thumbnails": LLiniial Show Thumbnais |

Then you will get flipbook shown with below initial interface:

Fup PDF Pro

(5) Background Config

i. Background Color:

l [EBackground Config
| . ElBackground Color
[ Gradient Color A CIoxFFFFFF
[ Gradient Color B M 0x000000
I Gradient Anale 30

o Gradient Color A

Gradient Color B

Define background for your flipbook with gradient color or pure color (the same color for
"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between the two
colors.

Copyright 2010 by FlipBuilder.com
-19 -



e G . . . .
- - E’, @ Convert PDF to Digital Shopping Catalog Utility
: User Document

ii. Background Image (set in Classical and Spread templates):

ElBackground Image
Image File
Imaqe position

Click the icon " =" to choose background image from your computer, and there are 11 kinds
of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

iii. Background Image (set in Float template):

BE)Background Image
A Outer Image File E: \Program..]
Image position Scale to fit
[inner Image File E:\Program..,
Image position |Scale to fit

The Float template enables you to add two background images: Outer Image and Inner
Image. You can make Inner background image to show special information, such as
advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to
choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle
Right, Bottom Left, Bottom Center and Bottom Right

(6) Flash Window Color

|

|\ 0x00001 |

Flash Window Color

This color will be applied on all flash windows, such as the book window, "Help" window,
"Print" window and so on.
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(7) Page Background Color

Page Background Color | Il0xFF8040

When load pages, or if the page number of your PDF file is odd, then the page (the last page)
will show with the "Page Background Color".

(8) Book Proportions

| BIBook Proportions !
Page Width 1052
Page Height

Please note that the values are not fixed in pixels or inches, they just represent a ratio for
"Page Width: Page Height", and the book size will be changed depend on your Explorer
Window Size.

(9) Book Margins

i. Book Margin (set in Classical Template):

Book Margin |50 |

¥

Margin

~ Margin

"Book Margin" refers to the distance between the book and the toolbar.
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ii. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

ttom )

(10) Page Shadow
EPage Shadow }
Left page Shadow !50
Right page Shadow !_25
Page Shadow Opacity }0. 5
Lefe page Shadow

Right page Shadow
The value also takes the value of Book Proportions as reference, and the value interval of
"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.

(11) Hide Book Frame Bar

| Hide Book Frame Bar \Yes |

If don’t want to show the book frame bar, choose “Yes” in this option.

(12) Right to Left

If the language of your file is read from right to left (such as Arabic), then choose "Yes" in
"Right to Left" option:

| Right To Left EYes

Next Page

k’ {
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(13) Hard Cover
If you want create hard cover effect (a book bound with rigid protective covers) for your
flipbook, choose "Yes" in "Hard Cover" option:

Hard Cover Yes

(14) Flipping time
Flipping Time 0.6

Sets page flipping time in seconds according to needs. (Recommended second value is 0.6)

(15) Page Number

If you don't want to count in the cover page, table of contents pages into the actual page
numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)".
For example, the first 3 pages are Table of Content pages with Roman page numbers, and

set Arabic page numbers from page 4, then you will get page number box like below:

[ElPage Number
Start Page Number (Roman) 0
Start Page Number (Arabic) |3

Front Cover RPage:

Pages: 1/8
The Fourth and Fifth Pages:
Pages 1-2/8

(16) Minime Style
To present Page-flipping eBook pages directly without showing toolbar, especially when you want
to embed eBook into a small area in existing webpages, then you can use this "Minime Style":

EMinime Style
Use Minime Style Yes
Width 400
Height 300
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The Minime Style will trigger when the Width or Height of the Flash Container is less than the
defined value. You can also always show the page-flipping eBook in Minime Style with adding a
parameter to your URL like this: www.yourdomain.com/index.html?alwaysMinimeStyle=true .

4. Flash Control Settings

[ElFlash Control Settings ‘
Security Settings |No Security
[FHLinks
Google Analytics ID

(1). Security Settings

| Security Settings Single Pass |
If you want to protect your flash books with passwords, you can click "..." icon to enter into

"Flash Security Config" interface:

Note:
Single Password option means that users need the password o view the flash book

Exclude Front Pages option is %0 set a page number, all latter pages can't be
viewed without inputting password,

Secunty Type
’ o Seaurity
| |
\]
AN 9 Sngle Password: 123456

Protect Page Range
A Pages

© Exclude Front Pages 0

(I

Select "Security Type->Single Password", and input passwords into the box (there is no
restriction on password format at present). You can also set "Protect Page Range" as "All
Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4
algorithm to protect eBook pages, the eBook content pages will show nothing without
permission.)

(2). Links

Mouse over color

Link alpha

Open Window

Enable after zoomingin  |En:

Create your professional fipping book with PDF files
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If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page"
interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers
to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent),
and "Open Window->Blank/ Self". The links also can be clicked after zooming by setting
"Enable after Zooming in->Enable".

(3). Google Analytics

Google Analytics ID
In the HTML output format, you can add statistics by using google analytics. You can get
more information about Google Analytics ID from http://www.google.com/analytics/ .

Besides, Export Theme

If you want to save the current template settings as your own style template for later uses,
you can click "File->Export current settings as Theme" button to storing all current template
settings, include the background images, margin values, toolbar buttons and so on.

Then when you want to use later, just click "File->Import Themes", the theme will be added
to the templates selecting interface. Download more themes from FlipBuilder now:
http://www.flipbuilder.com/templates-themes/theme.html .

IV. Edit Pages

Now you can use Flip Shopping Catalog to edit imported pages directly, no matter you want to
add shopping price, item, product detail photos slideshow, link, video, sound or image file. Just
’ 8 - Edit Pages

click "Edit Pages" button! —/ l to enter into the editing interface:
= [E=rey ==

Edit Page for Shopping Cart_ - b .

B | Link Properties

-A:wn Options

Over Cobor: Over Alpha:

Down Color: Down Apha: 20 B

& FlipBuilder Shopping Page Normal Color: Il Nomral Apha: 1 B
Sample Shopping Page page 8-9 : w:

)

=

Resources to Build Catalog. ,ﬁg.ﬂ t“é
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1. Text Button

—
Click the icon. and then draw a button on a page, then define properties in below panel:

Text Button Properties

Font Color:
O Down ® Up ® Move
URL:
® Over ® Out

Advance Action Options

® Go to page € Open aink ® Cal Javascript function
® Open Flash Window @ Ply Audio ® Photo Slideshow
URL:

Link Target: Bhank

Define Button Text, set link URL, there are many different action options, like Go to page, Open a
link, Call Javascript function, Open Flash window, Play Audio and Play Slideshow.

2. Price Icon

Click "Price" icon to add price for products like this:

You can also edit the icon type yourself in Properties panel:

Properties

Hint
Price Unit
Price

Background Color © Down ® uUp ® Move
® Over ® out

URL:

. " ® Go topage 1 Openaink ® Call Javascript function
Advance Action Options
® Open Flash Window ® Play Audio ® Photo Skdeshow
URL:
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3. Add Product Photos

Click "Product Photos" icon to add images to pop-up in slideshow format:

Photos

URL Action

./files/pageConfig/1.jpg Delete

./files/pageConfig/1.png Delete

Delete

./files/pageConfig/2.png

Add Images
| Advance Action Options; O Down @ Up @ Move

® Over ® Out

® Go topage ® Open < 'k M Cal Javascript function

® Open Flash Window @ Phy Audio ¥ Photo Slideshow

4. Add Button from Resources
Flip Shopping Catalog also provides many nice and typical resources for you to use on ebooks.

De—
Click icon to add the icons onto pages, you can also use your own icons:

x
Button Resources Properties

URL:

2| i (BT
G| ka R

® Over ® out

L I ; +an 3cton &
\
i } %\0‘ Hint:
® Gotopage © Openaink M Cal Javascipt function

— ® Open Flash Window @ Ply Audio ® Photo Sideshow

_“ o 1. URL:
% \-‘QN\ Link Target: Blank v
=]

5. Add Link

Click the icon and then draw a link box on the area you want to add link, then define
properties in below panel:
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™ Down ® Up ® Move

® Over ® Out

over Color: [ Over Alpha:

Down Color: Down Alpha:
Normal Color: Normal Alpha: B ® Gotopage f Openalink ® Call Javascript function
® Open Flash Window @ Play Audio ® Photo Slideshow

URL:

Link Target:
gl e

You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. For example, you can show a pop-up light box while readers clicking some
image on page, or pop-up a questionnaire or other Web Form by clicking some text. Just make
sure the parameter you set in "Function" can be called in from HTML page.

Example: Check "Call Javascript function" as action type, then input Function as
"testLightBox("Hello, this is a test"):

T HeS QU

® Down © Up ™ Move

® Over ® out

® Go to page ™ Open alink © Call Javascript function

Function:

And then make sure the Javascript wrote into the index.html page as below image shows (the
same as you set in "Link Function"):
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<head>
<title>PDF-BenU brochure 2010-100dpi</title>
<meta http-equiv="Content-Type" content="text/html; charset=utfi-g8" />
<meta name="Keywords" content="" />
<meta name="Descripticn" content="" />
<meta name="Generator" content="[Flip PDF version 3.0] at http://flipbuilder.com/" />

<style type="text/css" media="screen">
htrl, body { height:100%; }
boedy { margin:0; padding:0; overflow:auto; text-align:center;
background-coloeor: #Ifffff; )
#flashContent { display:none; }
</style>

<script type="text/javascript™>

function tescLightBoxlstrFrcmFlash){
7T

alert(strFromFlash);
}

</script>

6. Add Movie

Click icon and then draw a box like below on the page you want to insert FLV movie:

Then you can select and edit the movie in below panel (define video player skin color, play and
stop movie actions, etc.):

Movie Properties

Select FLV Movie

Player Skin Color:

Play Movie: When click Play button

2 When click Play button
Stop Movie:

When enter the page

When leave the page

7. Add Image

Click icon to draw image box and then select image (.jpg, .png, .bmp), set Action Options:
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Action Options

Action Options © Down ® Up ® Move
® Over ® out
® Go to page © Open alink ® Call Javascript function

® Open Flash Window @ Play Audio ® Photo Sideshow

URL:

T e S = e

8. Add Sound

Click the icon . to draw sound box and then select sound file, set other options:

Sound Properties

9. Add Flash

Click icon . to insert SWF flash into your defined area of flipbook page:
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10. Add Button

Click icon . to draw an area for inserting your image or SWF button file with calling actions.

The actions contain "Go to page", "Open a link", "Call Javascript function" and "Open Flash
Window". The before three actions are the same with the actions in "Add Link", the "Open Flash
Window" can help you to play SWF Flash or FLV Video in the pop-up window:

_ —
Button Properties Open Window Action Properties X

Select an Icon(SWF,Image), WLECEIBIEEE  open the window to play a video

Window Content: Select The File

Window Caption:

~ - -
D AR, T Window Width: Window Height:

ol el

® Over ® Out

® Go topage ™ Openaink ® Call Javascript function

© Open Flash Window

B B

11. Add You Tube Video

 You |
Click the icon and then draw a box on the page to insert You Tube video into pages directly.

You just need to define the video ID directly. For example the video link is:
http://www.youtube.com/watch?v=xKA6W!IqjB7c, then the video ID is "xKA6W!IqjB7c".

YouTube Video Properties

Video ID:

Video Parameters:

Play Movie: When click Play button

: When dlick Play button
Stop Movie:

When enter the page

When leave the page

H:
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12. Add Printable Area
If you want readers can click on some area of your book to print the area directly, such as
coupons which can be used to buy your presented goods, you can add a "Printable Area" on

-
pages by clicking the icon , and then draw the area on the pages, set title and description:

s Sim ;
g =~ /{1 1 Link Properties

gy

Color: B over Apha:

=Y

Border Color: Border Width:

Title:

Description:

13. Copy and Paste
If you want to add same links, images, videos, audios to different pages, you don't have to repeat
the "Link/Image/Video/Audio added" operations once and once again, just select the link object,

click the copy button and then go to the other page to click the paste button mdirectly.

14. Apply All
If you want to use the same link, video, audio, image or button on all pages (or all odd, even
pages, or your customized pages), you can select the object and then click the Apply All button

)
, then define the apply page range in pop-up window like below:

Page Ranges

™ AllPages ™ 0Odd Pages ™ Even Pages

® Custom range:

After adding links, flash, movie or sounds, you can click the icon to save the settings and

back to the template setting interface.
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V. Language Options Interface

Click "Option->Flash Language", you will enter into the Language Settings interface as below
shows:
' Language Settings '—-—_-ﬂ &

You can new or edit a language for the flash flipping book.
The Labled column below is the string that will be displayed in the flash.
v The language wil be list in the flash template settings

Language Name: | Chinese. A_v] [Auewm [ X pelete ] [Q Save as... | [ 35) Load... ]
Language Settings
Label Labled REETT
First Button -0
Next Page SButton T—@R £
Last Button fE—}R
Previous Page Button #—m -
Download Button T#
Print Button $TED
Search Button ok
Book Mark Button 8%
Help Button 240
Enable FulScreen Button 2R
Disable FullScreen Button B8 il
|_Sovind M B dbnn TTomES

Panel Description:

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books
in defined language, and the program provides you five different languages for you to use:
English, Chinese Arabic, French and Greek.

ERKREAIE Hne - M

Arabic
Chinese

French
Greek

You can also add other language for your own uses:

1. Click the button [ - Hew La"guagej and define name for the new language:

— New Language ﬂ‘
New Language |
Name: French
Copy From: |Engich 2
e ]

Click "OK" to save the new language in the list;
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2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box,
then click "Save And Edit Next":

Language Settings

Label

Next Page Button
Last Button Last

i Edti Language Item

Previous Page Button Previous P& ey e
Downioad Button Download ANguage |
Print Button Print
Search Button Search Label : First Button
Book Mark Button Book Mark
Help Button Help |abeled:  Premre]
Enable FulScreen Button Enable Fulls
Disable FullScreen Button Disable Fult!

| Camind M B by Py |

| saveandedtext | |

oK

3. At last, you can get all Labels translated into your new language as the images shows:

Label

First Button

Next Page Button

Last Button

Previous Page Button
Download Button

Print Button

Search Button

Book Mark Button

Help Button

Enable FullScreen Button

Disable FullScreen Button
CanimAd Nin Bidban

Labled

Premiére

Page suivante
Derniére

Page précédente
Télécharger
Imprimer
Rechercher
Réservez Mark
Aide

Activer FullScreen

Désactiver FullScreen
la CatimAd

Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:

33 Load...
Load language file saving before for current using:

After setting template and language, click

apply the settings.
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VI. Output Interface

Output Option E
Output |
Output type
P oo e R Ko
» J
Also Make Mobile Version Make output page-flipping eBook works on iPad, iPhone and Android mobile devices
Path
Output Folder: (E:\ijsersMdrﬁiﬁiﬁtraﬁirbesktop\ﬂibbook [ Browse... ] [ Open ]
File Name: index .html
Options
HTML Title: demo
[[1Burn to €D
CD Writer {0:1:0,G: PLDS DVD-ROM DH-16D5S VD15
| IMake it automatically play the flipbook in CD
[ Cancel ] [ Convert
Output types:
1. HTML

@ o

»

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:

Options

HTML Title: demo

Set Keywords, Description or even Script in the below interface:
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Advanced Settings &
HTML Advanced Settings
HTML Meta Settings
Title: demo

Keywords:  pdf, flipbook, page-fiipping, ebook, online, website, fiash, background, music

Description: This page-fipping eBook shows you the stunning flash effect on PDF pages, a

Add Scripts

You can put some tracking
code such as Google
Analytics here,

Need dosed <saript>tag!

This output type is for compressing the created files into an integral ZIP package which can
be sending out as attachment directly. You can also define HTML Advanced Settings by

clicking "Advanced" icon: &

Your recipients just need to uncompress the ZIP file and then they can view the HTML
flipbook instantly:

, files
\9 demo.html

book.swf

Uncompress

3. EXE

4

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

JR——

“
F)
demo.exe

You can also define Icon and Opening Window Size in Advanced Settings:
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1:,9

-

' Advanced Settings &‘

Exe Advanced Settings
Exe Window Info

Caption: demo
teon: R [ e | [ pefaut |
Window Size Opton

Maximized Custom Size

9 Full Screen

r
i

Cancel

If you want to make executable application to run on Mac devices, you can output as
"* app" format.

5. Mobile Version

[¥] Also Make Mobile Version

You can even output Mobile Version while choosing HTML or ZIP format at the same time.
After creating mobile versions, you just need to output all files online (including HTML, SWF,
"files" and "mobile" folders), then you can visit the flipbook page through your mobile
browser.

6. Burn to CD

[¥]Burn to CD

CD Writer {0: 1:0,G: PLDS DVD-ROM DH-16D55 VD15 v

Disc title: Page-Flipping eBook

[¥] Make it automatically play the flipbook in CD

After choosing output type, then check the option "Burn to CD", set "CD Writer", define
"Disc title".

How to make created eBooks available for others online, more details this support page:
http://flipbuilder.com/support/how-can-i-share-my-created-ebook-online.htm .

At last click lM]button to output flipbook in your defined type.
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VIl. Batch Convert Interface

E Batch Convert

) Add PDF Documents

| 0
| \Jgp AddFies ||y Add Folder = 3¢ Cear Al
Name Path
J~Flip Printer E:\Useful Documents\PDFs Flip Printer.pdf
JFlip PDF E:\Useful Documents\PDFs\Flip PDF.pdf
JFlip Word £:\Useful Documents\PDFs Flip Word.pdf
J=Fiip PPT E:\Useful Documents\PDFs\Flip PPT.pdf
@)  Settings
Output Settings | PDF Settings
Output type

3’ @ =him %Eg O =dp {“% O =exe ‘, 0 =app

[V] Also Make Mobile Version  Make output page-fipping eBook works on iPad, iPhone and Android mobile devices
Path

Output Folder: C:\Users\Administrator\Desktop\flipbook

File Name: {PDF FileName} v html
Flip Printer
Options
HTML Title: My FlipBook =
My FlipBook

[ Merge All PDF Files to One FlipBook

) Convert to Flash
|

» Convert to Flash

1. Add PDF Documents

s Add Fies ‘

Click this icon to add PDF files from computer;

‘M1 Click this icon to add all PDF files in the folder (include sub-folders).

You can also remove some unwanted PDF, move up/ down files, or clear all documents.

X Remove % Clear All @ Move Up @ Move Down

2. Settings

(1). Output Settings

i. Choose Output Type

Output type

[¥] Also Make Mobile Version  Make output page-fiipping eBook works on iPad, iPhone and Android mobile devices

ii. Choose Output Path

Path

Output Folder: C:\Users\Administrator\Desktop [ Browse... ][ Open ]
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You can also define output name pattern with FileName, Title, Subject and so on:

File Name: {PDF FileName} | E]
{PDF Title}
{PDF Subject}

DF Author
oD

And after defining the File Name, you can preview the result example below:
File Name: {PDF FileName} Flipping Book +

Flip PDF Flipping Book

iii. Define Output Option

Options

Caption:  {PDF FileName} v \§ Advanced

Flip PDF

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon,
Window Size for EXE flipbooks:
[ acvanced Settings - EH: Advanced Settings et

HTML Advanced Settngs i |

Exe Advanced Settngs i \
HTML Meta Settngs Exe Window Info
Tite: demo Caption:
Keymords:  od¥, fiobook, page-flopng, ebook, online, website, fash, badground, music
L — |
- Teon: ot |
DRescrotien: s page-fippng eBook shoms you the stunning flash effect on POF pages, 3 - ) i ]
Add Sorpts Window Sze Option
You can put some tradkng Maxmized Cystom Size
code such a5 Google
Analytics here.
Need dosed<saript>tag! 9 ful Screen

iv. Merge All PDF Files to One Flip Book

[¥]Merge All PDF Files to One FlipBook:

(2). PDF Settings

i. Page Range

The Page Ranges to Import

") All pages

Example:1,9-21,30

You can convert "All pages" or just "Custom range";
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ii. Watermark

Watermark

1l 4 Place a custom text or image
” Watermark(Stamp) to the file(s)

>

Click "Set Watermark" icon to enter into "Watermark" interface:

Option -

fax )

Watermark

V] Applying Watermark

Watermark Name

71 A Text -FINAL

[] A Text - comPLETED

[T A Text -DRAFT

| 7] A Text - FOR PUBLIC RELEASE
il ] A Text - INFORMATION ONLY
[7] A Text - NOT FOR PUBLIC RELEASE
[Z1 A Text - NOT APPROVED

)| [T A Text - Company(Tie)

[ A Text -LOGO (eft-top)

[T A Text -LOGO (Right-Top)

[7] A Text -LOGO (Left-Bottom)
[1 A Text -LOGO (Right-Bottom)
7] A Text - Dynamic - (title)

| [ &= tmage -LOGO

Type

[P2F- 9 Text - CONFIDENTIAL Text

Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Text
Image

m

)

X ¥ ¥

<

4

Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add
Text Watermark, Add Image Watermark, Delete, Move Down/ Up.

iii. Page Quality

large file size .7
Higher quality larger file size

Medium guality medium file size
Low quality small file size
Lower quality smaller file size

Choose quality and size type from listed five kinds.

iv. Other Options

Import bookmark
page-flipping eBook;

Import links

[V]Enable search

l}, Convert to Flash

If your PDF file has links, check this to enable in flipbook;

If your PDF file contains bookmarks, check this option to use in output

Check this option to enable search functionality in created flipbook.

At last, click icon to batch convert listed files together.
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VIll. Use Flip Shopping Catalog in Command Line

You can also use Flip Shopping Catalog in Command Line.

Flip Shopping Catalogfessional Command Line Usage:

PTCMD.exe [Options]

-f<PDF File> The source PDF file.

-o<output folder> Specify the folder for the output files.

-t[html|zip | exe] Output type. Default is html.

-n<OutputFileName>  Specify the name for the output file.

-c<caption> Caption for HTML or EXE.

-s<Flash settings> Value format is:<Template name>#[<Theme name>|
<txt_settingfile path>].
<Template name> could be: Classic, Float, Spread.
<Theme name> are list in the "Select a template" window,
such as Blank,Blues,Nostalgia.
<txt_settingfile path> is the file that you export

with "Save the template settings" function

-r<page range>. The page range that you want to import from PDF File.
Range value string like:2-15,33,35-36,or All.(Default: All)

-g<import quality> Count be 5,4,3,2,1.5 specify the higher quality larger file
size;1 specifies lower quality smaller file size.(default:4)

-R<GS|SWF|LIB> Render engine options. (Default: GS, Ghostscript render
engine)

-b<Y|N> Import bookmark yes or no. (Default: Y)
-I<Y|N> Import links yes or no. (Default: Y).

-S<Y|N> Enable searchable or not.(Default: Y, enable searchable)
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-k<html key words> Set the keywords for html output file.
-d<html description>  Set the descriptions for html output file.
-j<html javascript> Set the javascript for html output file.
-i<icon file path> Specify the icon path for exe output.
-w<window size> Specify the size of exe window.

Value could be: M,F, or some string like:800,600.
(width is 800,height is 600).

Examples 1:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -thtml -c"Title"
-s"Float#c:\my_ebooksetting.txt" -r"1-8,9-14,42" -q4 -R"SWF" -bN

Examples 2:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico"
-c"Title" -s"Float#Blues" -r"All" -g5 -R"GS"

Examples 3:

PTCMD  -f"C:\input.pdf"  -o0"C:\outputfolder" -n"index" -tzip  -c"Title"
-s"Float#Blank" -r"All" -5 -R"GS" -k"html key words"\

Return Code:

Success

Input file not found

Parameters are invalid

Failed to load PDF

Failed to import bookmarks

Failed to import links

Failed to import searchable information
Failed to save the output file.

N HREWNR

Copyright 2010 by FlipBuilder.com
-42 -




- - : \/ Convert PDF to Digital Shopping Catalog Utility
: User Document

License Agreements

All copyrights to Flip Shopping Catalog (the Software) are exclusively owned by
FlipBuilder.com. For more information, visit our website at www.Flipbuilder.com .

Anyone may use this software but all the page-flipping eBooks generated will automatically
have a demo watermark on the first page of them. To remove the limitation you must
register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed, provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by A-PDF Solution.

Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.
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How to Order

Order Online (http://www.flipbuilder.com/flip-shopping-catalog/index.html) or Order Toll

Free 1-877-353-7297 (When you order toll free just give the operator the product number of
the product you would like).

How to purchase online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)
4. Check the information you filled previously and click "Place Secure Order"

Other Order Ways—With Phone/Mail/Fax/Check:

If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.
Once submitted online, the appropriate information will be provided to you in your web
browser to send your payment to us offline.

100% unconditional 30 Day Money Back Guarantee

Want to custom the program or have other questions about purchase?
Contact us at alice@flipbuilder.com .
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Support

You can easily search or browse our frequently asked questions, and learn tutorials about
products, and get your registration code back. If you are not satisfy with the solutions
provided, please contact support team for help.

1. Frequently Asked Questions

You can find answers to questions about technique issues here:
http://www.flipbuilder.com/support

2. Get lost license code

Click here to look up the order » (http://www.regnow.com/cs/orderStatus)
You can pull up a copy of your order by entering your email address. After you find your

order, you may view its status, view details of your order (including the license key), and
obtain the invoice.

3. Contact Us

If you have other questions or requirements, contact us directly through our support Email:
alice@flipbuilder.com, we will respond you ASAP.
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